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IriSearch Pro is an extremely sophisticated tool, it manages Image Capture, Photo
Storage, Client Details, Condition Stage Reading and a great Reporting System
which includes suggested Herbs, Homeopathics and Supplements for
underfunctioning organs.

IriSearch Pro provides photographic tools to enable enhancing of less than opti-
mum image captures.

IriSearch Pro also offers valuable resources of benefit both to practitioner and
student. This program can be used with Naturopathic Technologies Digital Iriscope
or stand-alone.

Welcome to IriSearch Pro 2000
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Your NT Digital Iriscope has been pre-set for maximum performance and functionality - no addi-
tional procedures or settings are required to be configured or modified by the user. If any system
setting is changed, Naturopathic Technologies can assume no responsibility for any system degra-
dation or failure. All critical system settings are provided should you require to reset them for any
reason.

Your system comes with instructions on how to cable up the iriscope. The procedure is the same
as cabling up a standard computer with the addition of setting up the video camera. If you do
not feel confident with cabling up a computer, we suggest you call in your local computer techni-
cian to do it for you. Otherwise we can take you through the procedure step-by-step over the
phone.

The system comes with 12 month  manufacturers return-to-base warranty as standard.  If you
have a hardware system failure, contact your service agent. The warranty does not cover user
damage, configuration problems or software issues.

Naturopathic Technologies can offer training at our office in Melbourne and some other capital
cities. Please call for further information.

We can assist with any hardware issues on-site anywhere in Australia. Any requirements that are
outside of the warranty agreement can be resolved with a technician for a negotiated fee.

Naturopathic Technologies cannot assist with the installation, operation or training with software
other than that we supply. If you are new computer user and unfamiliar with Windows  or other
software, we suggest you pursue information and training at a local T.A.F.E.  or other college, or
from tutorial books or videos. We can however, offer you video tutorials on Windows   and other
Microsoft products. Call for further information.
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If you have purchased an NT Digital Iriscope, IriSearch Pro has already been loaded for you. Please
skip this section.

Make sure you have Window 95  or later loaded on your computer as your operating system.

Insert the IriSearch Pro CD into your CD-ROM drive. The CD is auto-start and will automatically run
the install program. Follow the prompts to install the program.

The first time the program is run a random code will be generated.  A dialog box will be displayed
each time you run the program until an access code is typed in.

You must now type in an 8-digit access code to match the code generated. The supplier of this
software will provide you with this access code. The program will allow you to type the code in at a
later time. You must type in the code before a period of one month from your installation date.
Once a valid access code is typed in this dialog box will no longer be displayed. If the code is not
entered within a month, the program will cease to operate.

If problems occur during installation re-run the install program. Make sure all other applications are
closed when installing. If problems still occur, contact your vendor.
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Personal Computer with a Pentium III 800 Mhz or higher processor.
Microsoft Windows 98, 2000 operating system.
64 MB of memory.
Once CD-ROM disk drive.
Microsoft Mouse or compatible pointing device.
25 MB of free hard disk space.

Personal Computer with a Pentium III 1.0 Ghz or greater processor.
Microsoft Windows 2000 operating system.
128 MB of Memory.
16 or 32 Bit colour.
1024 x 768 screen resolution.
52 Speed CD-ROM.
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This is a quick start guide for first time users to give you a brief explanation of what is needed to
get you up and running.  Please read each step first before proceeding.  For a more comprehension
guide to each menu item, and the use of the toolbar and other functions, read the latter section of
the manual. For a thorough description of how to use certain functions, please read the Tutorial
very carefully.

1. Run the IriSearch Pro program by double clicking on the IriSearch Pro icon or selecting from the
Start/Programs/IriSearch Pro group.

2. Load a picture.  This can be from clipboard or a file on disk or a direct capture from a camera.

3.   To capture an image from the NT Digital Iriscope is a simple process and requires only a few
steps. With IriSearch Pro up and running perform the following steps:

Click the Camera icon on the Buttonbar. 

Or using your info box, select the capture Image box.

Please Note: if you can’t see your information box to the right hand side of the screen, select
Window|Show InfoBox.

This will open the live video window to capture your image.

With your client sitting comfortably in the stand, turn on the lights at a level bright enough to
illuminate the eye. Focus the camera with the rack and pinion to obtain a sharp image.

When you are satisfied with the image sharpness turn up the lights to a level that illuminates
the eye sufficiently.

Select, Freeze image, then close the image capture window,and paste into IriScan 2000.
     Please Note: These few steps may differ according to your capture card.

Choose Edit|Paste or simply click on the paste icon  to paste your image from the

clipboard into IriSearch Pro.

Proceed through the above sequence for the next iris.

The capture window is used in exactly the same way to capture all photographs. If you have a
microscope or other camera supplied by NT, the procedure is the same. If you have multiple video
sources coming into your instrument, you will have a Switchbox to switch between the devices.

IriSearch Pro will allow you to capture any body part including the tongue, live-blood, tissue and
you can also capture clients x-rays, ultr and CT scans if you have a light box.

Contact NT of you have any queries on equipment if you wish to capture photographs from other
sources.
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4.     You will need to set up a folder structure for your photographs. The IriSearch Pro Client List
can help you with this. See Client List for further details.

Once you have captured your photographs, it is best to save them immediately. To do this, select
the following:

Choose File|Save As from the menu or click on the Save icon  

The Save As window will display and you will be prompted for a filename. Enter the filename and
click the OK button.

It is also a good idea to tag your files with a label for left and right. You may include the whole
word or just the first letter.

5.    There are two ways to deal with files; have Client List organise your files for you or do it
manually. We will do it manually first; it is useful to know how to do this, as you may want to set
up specific folders for some of your work. To open manually do the following:

a) Select File|Open in the menu or click the Open icon.

b) The Open File window will be displayed with a list of your files.

c) To see a Thumbnail image of a file, click on the file to highlight. This will give you a Thumbnail
in the window to the right of the screen. To see an enlarged view, click the Magnifier icon on
the top right hand corner. This will display a larger image for you to preview.

When you have located the file you want, either click on the filename or type the file name and
then click the OK button.

6.   Select the chart you wish to load. This selection is made from the Chart Menu.
Choose Select and click on the chart you wish to use.
Different chart overlays are available depending on the configuration of the software that you have
purchased. The principle is the same with all overlays.

Now you need to adjust the eye overlay to fit the eye image.  There are several steps involved
in this. We will go over each one.  Notice that there are three rings displayed. The outside ring
must be adjusted to the outside of the iris.  The inner-most ring is to be adjusted to the pupil.
The middle ring is to be adjusted to the stomach zone. If you have purchased “The Iridologist”
and are using the Integrated Iridology Chart, there is a fourth ring. This is to be fitted to the
Collarette (ANW).

Now load an overlay. This can be done either from the Chart Menu or by selecting the Load Overlay
toolbar icon.  There are two commands, one for left eye and the other for the right eye. Select the
one you want.
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First, move the entire overlay so that the outer overlay ring is located centrally over the
iris.  To do this move the mouse pointer to approximately the centre of the overlay.  Press
and hold the mouse button and drag the overlay to the desired position.  Notice the overlay
will move wherever the mouse moves.  Drag it until the outer ring is centered over the iris.
Once you have moved it to the correct position release the mouse button.  Don’t worry
about the inner rings for the moment we will adjust those later.

7. Next we need to enlarge/reduce the size of the outer overlay ring so it is the same size as the
periphery of the iris. To do this, move the mouse pointer to anywhere on the edge of the outer
ring. Press and hold the mouse button and drag the outer ring until it is the same size as the
periphery of the iris.  Once you have moved it to the correct position release the mouse button.
Now check again that the outer ring is central, if not go back to step five and re-adjust the
centre.

8. Now we are ready to adjust the inner ring.  First, we need to make sure that it is central.  If
not, we have to do what is called an offset adjust.  This is to offset the inner ring without
moving the outer ring. This is required, as the pupil is not quite central in the iris.  To go into
offset adjust mode we need to select the Chart|Offset Centre menu command or select the
Offset Centre icon on the Toolbar.  Once activated move the mouse pointer to the centre of the
overlay.  Press and hold the mouse button.  Now drag the overlay so that the inner ring is in the
centre of the pupil.  Once this is done release the mouse button.  Now we must deactivate the
offset adjust mode.  This is done by selecting Options|Offset Centre menu command or the
Offset Centre icon on the Toolbar again.

9. Now we need to adjust the size of the inner ring to match the size of the pupil.  This is done in
the same way as we adjusted the size of the outer ring.  Move the mouse cursor to anywhere
along the edge of the inner ring and press and hold the mouse button.  Drag it to the correct
size and release the mouse button.

10. Now we can adjust the size of the middle ring or the stomach zone ring. Use the same proce-
dure as adjusting the inner ring.

11. Next fit the ANW ring (Integrated Iridology Chart only).

Now we have finished adjusting our overlay.  If any of the overlay is not correctly adjusted
repeat the appropriate step above.

To make sure our overlay will not accidentally be moved we should lock it in place.  To do this
select the Chart|Lock Overlay menu command or the Lock Overlay icon on the Toolbar.

Now we can begin our analysis.  The chart is now ready for use. There is an Info Box on the
right hand side of your screen. This contains information about the current file as well as chart
information. If the Info Box is not open, select Window|Show Info from the menu.
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When you move the mouse pointer round the chart, you will notice a few things happening.
1. Current Location Intensity. This provides information on the colour breakdown of the
area that you are currently pointing at. The letters on the left hand side represent the primary
colours Red, Blue, Green and “I” stands for Intensity. On the right hand side are the complemen-
tary Cyan, Magenta, Yellow and “K”  stands for Black. Under these figures is a sample block of
colour that represents the colour of the current location. More on colour sampling later.

2. Co-ordinate. This section gives the x and y co-ordinate of the current location. If any
measurements are made, they are recorded here. More on measurements later
3. Analysis.  This section provides three bits of chart information, the current Location of the
mouse pointer, the Condition Stage of that location ie. Nomal, Acute, Sub-acute, Chronic, Degen-
erative and the Stomach Zone condition ie. Nomal, Mild Hyper, Hyper, Mild Hypo and Hypo.

4. Chart. This section identifies what the current chart is set to and if there is any rotation.

Any chart that you have loaded may be rotated. This is particularly useful if you have the “Time
Chart” and doing a Time Risk Analysis. To rotate the chart, choose Chart|Rotate from the menu
or click the Rotate Chart icon on the Toolbar. To set the rotation factor, click the up or down arrows
next to the Rotate Chart entry box. Alternatively you can enter the factor you wish to enter. A
negative number will rotate the chart anti-clockwise and a positive number will rotate clockwise.
The chart rotate function rotates in degrees from 0 to 360. If you wish to rotate by minutes, 6
degrees = 1 minute.

System charts have been provided to show the body system components on the chart, along with a
system graphic showing the relative areas in an anatomical chart (note: this function only works
with the America Chart loaded). This is useful to show the relationship between the iris and the
body, whether for yourself or your client. To chart a system, do the following:

a) a) With the American Chart loaded select Chart|Body System or the Body System
icon on the Toolbar. This will display a list of systems.

b) b) Select the system you wish to display. The chart will now block the components of
that particular system and display an anatomical chart on the System page in the Info Box.

c) c) To see the iris parts within the current system, select Chart|Reverse Blocking or
click the Reverse Blocking icon on the Toolbar.

There are two views available to any chart, Full and Minimum. The default mode is Minimum. If you
wish to view the chart in its entirety select Chart|View|Full from the menu or click the Full/
Minimum icon on the Toolbar.

This view is also available when body systems is on.

Other charts supplied with the software include Zone, Sector and Psychological. These are trivial
but can be useful to the student or to graphically show these concepts to clients. The method for
loading these charts is the same as above.
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We suggest that you edit your client list before your client is seated and in consultation. To do this
follow this easy steps:

Click on the client list button on the toolbar. You will notice the following screen.

To add a new client, click on the add client button, type in your client’s name and click close. You have
now created a folder for your client in which to store thier images.

Please refer to the quick reference manual to capture the image, select the correct chart overlay
and how to place it on your image correctly.

Your next step is to save your image into your clients folder that you have previously created. To
save an image into our client list, simply click on File, Save. The following window will appear:
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You should be in the IriSearch Pro directory. You can check thos by looking at the top of this
dialogue box, and look at save in.
If you aren’t click on the drop down arrow to the right of this window and choose c: now select
Program Files, and finally IriSearch Pro.
You will notice various folders here, you need to select the Clients folder.

All the clients that you have entered in the add client list will appear as folders here.

Double click on a folder and save the image in the clients folder. (I have clicked on Smith,
Rubee). Be sure to click only on the folder beside the name, otherwise you might rename the client
accidently)
You will notice any other images that you have saved previously, for this client appear hear in this
folder.
Type in the appropriate details in the file name and click save.Now if we click back on the client

list button      we will be able to see this image in the client list.

Click on the image you wish to display and you will be able to see a preview in the
preview window.
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STOP Before you begin please ensure that your screen resolution is on 800 x 600 pixels, although IriScan
runs best at 1024 x 768 pixels. (This setting is an absolute must for practicioners that have recently pur-
chase an iriscope or thoes that  have installed the quality upgrade)

To make sure that your automatic scan is as accurate as
possiable, if you are capturing a brown eye be sure to change
the normal tolerance level. To do this select File - Settings -
Program - select the Condition Stage, and change the normal
tolerance level to 7. For all other lighter irides keep this level on
10.

Be sure that you have selected the American Chart, you can check this by going to the chart menu
- Select Chart - American.
You now need to load the left or right chart overlay, and lock it in, you will now notice that the
Start Analysis button on the info box has now become enabled.

Now click on the Start Analysis section to begin the automatic scan
process.

Now watch before your eyes as the automatic scan process begins.

You need to decide if you are going to select each body
system individually or as a group.
If you wish to be selective and only chose one or two
body systems, use >As Group.
Otherwise to select all the body systems, use
>> As Group, which selects all body systems and
elements.
If you have made a mistake and wish to eliminate any
body systems in the scan select the item in the list and
use the “<“ button.

Now click on the Analyse Iris button.

The automatic scan function will go through each body
system and analyse each element, putting them into
five categories, acute, normal, sub-acute,  chronic,
degenerative.
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Previously we had to click on the get sample button to get an average iris intensity, this is now
done with the automatic scan function.

You will notice that each tab shows a different body system, and within these tabs, are the ele-
ments for the body system. This graph is linked up to your comprehensive report. (Please make
sure that you have selected the comprehensive report under the windows menu, report type -
comprehensive.)

To select the individual elements that you have concern with, simply by using the mouse either click
on the actual graph, or select from the notepad to the right of the screen. You will notice if you
select from the graph, this element is then highlighted on the notepad and vice versa. If you have
accidently clicked on an area that is no concern to you, simply by using the mouse, click on the
element again until it isn’t highlighted.
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Now click on the selected items, to add to the report. You can also add the current graph to the
report as well, or you may wish to add only the summary graph. A message will then come up
asking you to confirm this action, select OK to view your report.
You can now click close, when you have selected all your information.
(Please note you can still click on the iris if there is any particular area of concern to you, and this
will go directly into the report.)

Now click on the report button on the info box, this will open up your client report. Alternatively
you can choose windows menu, show reports. You will notice your clients name, date and time
at the top of the page, followed by the image that you have saved.

The client history button takes you to your client database, to store all their personal data.

You may need to adjust the images pasted here. If you wish to change the size,
just click on the image so that in the corners there are little black squares, using
the mouse drag one of the square corners out to the size you wish.
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Below is a quick reference to all the menu items of the Iridology program.

The File menu provides commands for creating new files, opening existing files, saving files, printing files, setting up your program
and exiting the application.

Client Select the name of a client to open.
Client Record Opens the client record database.
Open Open an existing image file.
Close Close the current file.
Save Save the current file, if its contents have changed.
Save As Save the current file under a new name.
Revert Reload image from disk status, destroying any changes that have been made.
Save Copy Save a copy on an existing file.
Import Import an image into the program.
Templates Loads the template control window.
Page Setup Set page characteristics for printing.
Print Print the current file.
Print Preview View a sample printout of the current file.
Settings Choose your settings for the program
Exit Exit Iridology application.

The Edit Menu provides commands to access the clipboard.

Undo Undo the previous operation.
Cut Move image from current window to the clipboard.
Copy Copies image from current window to the clipboard.
Paste Move image from the clipboard to new window.
Paste Into Pastes an image from the clipboard into the current image.
Clear Clear the image from the display.
Crop Keep selected region of an image.
Purge Remove unneeded information from memory.

Adjust and set properties of the current image.

Adjust Change colour properties of the image.
Duplicate                        Create a duplicate of the current image in anew window.
Stitch Joins 2 images together into one new image.
Hemispherical Stitch  Same as Stitch but with selectable orientations.
Image Size Change the size of the image object.
Image Canvas Size     Change the size of the canvas upon which the image is drawn.
Image Rotate Rotate the image.
Image Flip Flip the image on its axis.
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The Draw menu enables you to select drawing functions and configure how they will operate on your images when used.  Func-
tions are also included which allow you to annotate your images to suite your own personal style.

Mode Select the mode that the mouse pointer will funtion in.
Freehand Draw freehand graphics.
Line Draw line graphics.
Square/Rectangle Draw a rectangular graphic on your image.
Circle/Ellipse Draw an elliptical graphic on your image.
Fill Determines whether shapes that you draw will be filled with a colour or left clear.
Text Type text notes on your image.
Arrow Draws an arrow in variable sizes and colour.
Erase Erases any part of the image that your trace.
Colour Selects the colour to work with.
Line Thickness Selects how thick lines will be drawn.
Arrow Size Selects the size that arrows will be drawn.

Sharpen Sharpens an image or selected part of an image.
Noise Removes dust and scratches from scanned images.
Blur Softens or blurs an image or part of an image.

The View menu provides commands to change the way the image is viewed.

Normal Set image to normal view (100%).
Zoom In Zoom into the image.
Zoom Out Zoom out from the image.
Zoom to Selection Zoom into a selected region of the image.
Zoom By Select a percentage to zoom in or out by.
Full Screen View image at full screen.
Show Grid Overlay a grid on the image.

The Selection tool allows you to define all or part of an image for any additional processing.

All Clear marquee and select the whole image to work upon.
None Clear all selected marquees.
Inverse Make the active selection the areas around your marquees.
Region Shape Change the shape of the marquees that you draw to one of the following: Rectangle, Ellipse, Rounded

Rectangle, Freehand.

Select Provides a list of overlay charts  to select from.
Overlay Right Loads the currently selected chart for the right iris.
Overlay Left Loads the currently selected chart for the left iris.
Offset Pupil Allows you to offset the inner ring (pupil ring).
Rotate Allows chart rotation either clockwise or anti-clockwise.
Lock Locks the current chart into position.
Clear Removes the current chart from the image.
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View Switches the chart view between minimal and full .
Body System Identifies a particular body system and blocks those components on the
chart.
Reverse Blocking Reverses system blocking on the current chart and system to reveal the iris condition within that system.
Colour Selects the colour for the chart overlay.

The Test Menu provides access to other devices you may have installed with the NT Digital Iriscope. If you do not have an
Iriscope with any optional devices, this menu will not be active.

Iris Densities Displays the Iris Densities help file.
Iris Signs Displays the Iris Signs help file.
The Iridologist Displays the optional “The Iridologist” resource CD.
HyperHealth Displays the optional “HyperHealth” resource CD.
Diet Pro Displays the nutritional module of the program.
NaturBase Displays the optional “NaturBase” resource CD.

The Window menu provides commands to control the position and layout of application’s windows.

Cascade Resize and position all windows in an overlapping pattern.
Tile Resize and position all windows in an non
Arrange Icons Align all iconized windows along a grid.
Close All Close all windows.
Info Detail This page records information about the currently selected file.
Show Reports Shows Report Box Details
Show Tools Turns on and off the Tools Box.
Report Type Allows you to switch between Simple and Comprehensive report types.

The Help menu provides access to the help system and the about dialog.

Contents Displays the help contents page.
Search for help on Displays help topic index.
How to use Help How to use the Help window.
About Displays program information.
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The File Menu provides commands to access all your files. There are two main types of files; photographs and text records.

Allows the creation of a new client folder and provides access to all client images.
Please see pg9. showing how to use the client list.

Add Client Creates a new client in the client list.

Rename Client Allows you to rename any existing client.

Delete Client Allows you to delete any existing client.

Open Opens any file or group of selected files in the image list.

Select All Selects all images in the image list.

Close Closes the client list window
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The View menu provides commands for Viewing.

Toolbar Choosing the Toolbar will show or hide the toolbar.

Filter Choosing the Filter will show or hide the filter panel.

Grid Choosing the grid will show or hide the grid.

Eye Images Choosing the Eye images option will display a list of eye images.

Minimise/Maximise Choosing the Minimise or Maximise option will enlarge or shrink the display.

The File menu provides commands for entering a company logo, printing and exiting Client Details.

Update Table

Update table should be used to update your existing tables to our new table structure.

Print Open the printing screen.

Exit Exit Client Details.

Open Client Record
Opens the client record database. This database allows you to store, edit and monitor all client records. Client Records is a
powerful database module for those who want a system for medical records. This module has its own set of commands.



20

IriSearch Pro 2000 User Manual

The Table menu provides commands for Fixing, restoring and backing up the patient database.

Backup Backups up the client database.

Restore Restore is used to return to a previous client database.

Rebuild               Rebuild will fix problems with the Client database.

Pack                    Pack will cleanup the database of all deleted records entered into the database.

The Button Bar is used to move through the records in a database, and perform operations on the data, such as inserting a
blank record or posting a record.

The database Button Bar consists of multiple buttons.

When the user chooses one of the buttons, the appropriate action is performed. For example, if the user clicks the Insert
button, a blank record is inserted in the database.

This table describes the buttons:

First Sets the current record to the first record in the database.  This button is disabled if the current
record is the first record of the database.

Prior Sets the current record to the previous record.  This button is disabled if the current record is the
first record of the database.

Next Sets the current record to the next record.  This button is disabled if the current record is the last

The Records menu provides commands for navigating through the database.

First Sets the current record to the first record in the database.  This button is disabled if the current
record is the first record of the database.

Prior Sets the current record to the previous record.  This button is disabled if the current record is the
first record of the database.

Next Sets the current record to the next record.  This button is disabled if the current record is the last
record of the database.

Last Sets the current record to the last record.  This button is disabled if the current record is the last
record of the database.

Insert Inserts a new record before the current record.

Delete Deletes the current record and makes the next record the current record.

Unlock/Lock Locks or unlocks the current database. Disabling or enabling editing of records.
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Delete Deletes the current record and makes the next record the current record.

Edit Puts the database into Edit state so that the current record can be modified.

Post Writes changes in the current record to the database.

Cancel Cancels edits to the current record, restores the record display to its condition prior to editing.

Refresh Re-displays the current record from the database, thereby updating the display of the record.

The Toolbar is a row of buttons at the top of the main window, which represent application commands. The Toolbar is to the
right of the Button Bar. Clicking one of the buttons is a quick alternative to choosing a command from the menu.  Buttons on
the toolbar activate and deactivate according to the state of the application.

Button Action Menu

Equivalent

Exiting Client Details File|Exit

Maximises and Minimises View|Maximise

the screen or Minimise

The Print command prints the currently displayed patient. You will also be asked to specify whether to print the currently display
record or to print all records.

Use Print Setup Button to select a printer, and to set printer options.

To exit Client Details click on the Exit button on the main Toolbar or click on File|Exit.

record of the database.

Last Sets the current record to the last record.  This button is disabled if the current record is
the last record of the database.

Insert Inserts a new record before the current record.
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File Open The File|Open command displays the Open File dialog box so you can select a file to load into a new document
window.  You can also create a new document by naming a file that doesn’t currently exist.

File Close File|Close closes the currently active window.

File Save The File|Save command saves the document in the active window to disk. If  the  document is unnamed, the
Save File As dialog box is displayed so you can name the file, and choose where it is to be saved.

File Save As The File|Save As command allows you to save a document under a new name, or in a new location on disk.  The
command displays the Save File As dialog box.  You can enter the new file name, including the drive and direc
tory.  All windows containing this file are updated with the new name.  If you choose an existing file name, you
are asked if you want to overwrite the existing file.

File Save Copy Use this command when you want to save a new version of the current file with the same name. Save Copy will
insert the word ‘copy’ immediately after the file name.

File Revert The File|Revert command reloads the image from the disk and discards any changes that have been made since
it was originally loaded.

File Import Allows you to capture new images directly into IriSearch Pro.

Aquire TWAIN Source Capture an image from your selected TWAIN source.
Select TWAIN Source Select from which source TWAIN images are to be obtained from.
Camera Capture images directly from NT’s Digital Iriscope camera.

Use this selection to acquire an image from your TWAIN compliant device.

TWAIN is an industry standard developed by the image acquisition industry (makers of scanners, frame grabbers, etc.).  This
standard allows applications like IriSearch Pro to call the TWAIN driver supplied with your image acquisition hardware.  When the
driver is called, a dialog box will be displayed allowing you to make the necessary choices to acquire an image from your hardware.
After the hardware has acquired the image, the image will be passed back to the application that called it.

If you have purchased this software with NT’S Digital Iriscope, you have no need of this function. However, if you have purchased
the software only, this is a method you may use to grab images.
How to Acquire an Image
1. Select File - Import - Acquire TWAIN Source.  This opens the Acquire dialog box for your specific device.
2. Make your selection in the Acquire dialog box as outlined in its on-line help system, or user’s manual.  After you have made all
of your selections, and the image has been acquired, the image will be displayed in an Iridology Analysis window.

Use this selection to choose from the list of TWAIN compliant devices that you have connected to your computer system.

How to Select a Source :
1. Select File - Import - Select TWAIN Source.  This opens the Select Source dialog box.

2. The dialog box will display a list box of the available sources.  Make your selection and click OK (or press Enter) to select
the source.
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IriSearch Pro is able to capture images directly from the camera supplied by Naturopathic Technologies.  Select this option if you
have any camera installed by Naturopathic Technologies. Alternatively, click the camera icon on the Button Bar.

File Templates Displays the template window. This function provides you with the capability of creating standard forms
or templates to report to your clients. They can be created from scratch, copied and pasted into a file
from another resource (ie. “The Iridologist” etc), or edited at any time for an impromptu situation or
report. The first group is Charts. This is a special group and is linked to the current overlay chart. When
you click on a chart area (eg. Liver), a report will be placed into the Report window for viewing, editing
or printing (see Windows|Reports for further info). The other groups provided are Constitutions,
Symptoms, Diets, Supplements and Others. Some sample files are provided to give you an idea on how
this system works.

Page Set-up Allows you to change the way your documents will look when printed out on your printer.  You can also select from
different printers if you have them installed.

Print The File|Print command prints the contents of the active window.  Use File|Page Setup to change how the document will be
laid out on printer pages, and to set printer options.

Print Preview File|Print Preview opens a special window that shows how the active document will appear when printed.  The preview
window shows the page of the active document, as it would be laid out on printer page.  You may elect to include the
current overlay chart to be printed with the iris. Check the tick-box Print Overlay with Image to enable this feature.

File Settings Adjusts how the program operates: you may wish to change some of the parameters here to suit your individual
requirements. Settings also provides a method of calibrating your system for accurate and repeatable photogra
phy.

Monitor Setup loads a Grayscale Chart to calibrate your monitor. Configure IriSearch Pro to suit your monitor’s
display Capabilities. With the Grayscale Chart loaded, use the monitor’s contrast and brightness controls to
achieve the best viewing result. The optimum viewing condition is when all steps in the grayscale can be
separated.

Loads a Colour Balance chart to configure your printer to the monitor. Helps you to configure IriSearch Pro to calibrate
your printer with the monitor. Load the Colour Balance chart when you are setting up a new printer or wish to
tune your printer driver to match the colour display of your monitor. Refer to your printer manual for further
details on how to configure the settings. Only calibrate after you have completed the previous step.

This allows you to change advanced features used by IriSearch Pro.

Enable Foot Switch Turns on and off access to the foot switch Device. If you have an NT Digital Iriscope with the optional
Foot- Switch, you must enable this function. The Foot-Switch allows you to take a photograph without
having to use the mouse. Useful for children or clients that have difficulty with opening their eyes wide.
The inclusion of the Foot-Switch gives you another hand free.

Enable Image Previews in Open|Save dialogs  Turns on and off image previews. Image previews are useful as they display
a view of the selected  image without loading. If it’s not the image you require, you can ignore it and
proceed to the next image. You would only need to turn image preview off if working with
extremely large files (ie. 10mb or more). Large files will take a long time to load for
previewing.
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Enable Thumbnails Preview in Client List

Turns on and off all thumbnails previewed in the client list. Image thumbnails are useful as they display a small view of
the current list of images. You can view a history of all the images you have taken of a particular client without having to
load them. You would only need to turn image thumbnails off if working with extremely large files (ie. 10mb or more).
Large files will take a long time to generate thumbnails.

Enable Colour Sampling in Reports
Turns on and off the colour sampling function in reports. The colour sampling function is accessed in the Info Box and
allows you to record colour samples of any part of the iris. This is useful for monitoring any colour changes in the iris.
When you turn this feature off, the colour sampling will not be sent to the Report window.

Enable Colour Sampling in Reports
Turns on and off the measure function in reports. The measure is accessed by the Toolbar and allows you to record a
measurement of any part of the iris. This is useful for monitoring any changes in the iris. When you turn this feature off,
the measurement will not be sent to the Report window.

Enable Chart to Report Link
Turns on and off the Chart to Report Link. This function enables a link from the current chart to the templates you have
created under Charts in the Templates Box. This is a very powerful feature that allows you to print a personalised report
for your clients directly from an iris sign within your chart. For example, you may have created a report on the kidneys
with some information such as, functional description, suggested maintenance of this area, your prescribed treatment with
your modality (eg. Herbs, vitamins etc), a description of the products you’re prescribing and dosage, storage etc. All this
information will be reported when you click on the kidney area of the iris. This can be as simple or comprehensive as you
wish to make it. A sample report is provided for your information.

Changes the shape of images when they are pasted into IriSearch Pro. Use this function to obtain a perfect iris shape in
the event of any distortion occurring.

These settings allow you to adjust the stomach Zone condition calculation parameters. There are two parameters to adjust
the stomach zone calculation. The first is the Normal Level % parameter. This is defaulted to +/-10%. This means the
normal intensity level for the stomach zone is said to be between 40 to 60%. The second is the mild level % parameter.
This is also defaulted to 10%. This means a Mild Hyper intensity is set to 60-70%. Change these values to suit your
requirements.

Condition Stage calculates the current intensity at the mouse pointer, and presents this information as one of the following
conditions: Normal, Acute, Sub-acute, Chronic and Degenerative. The parameters have been pre-set, but if you feel you
want to modify the calculation parameters, you may do so.

There are five parameters to adjust the Condition Stage calculation. The first is the Acute Level % parameter. This is
defaulted to 20%. This means the acute intensity level for the Condition Stage level is said to be between 0 to 20%
intensity.

The second is the Sub Acute Level % parameter. This is defaulted to 40%. This means the sub acute intensity level for the
Condition Stage level is said to be between 21 to 40% intensity.

The third is the Chronic Level % parameter. This is defaulted to 60%. This means the chronic intensity level for the
Condition Stage level is said to be between 41 to 60% intensity.
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The fourth is the Degenerative Level % parameter. This is defaulted to 80%. This means the degenerative intensity level
for the Condition Stage level is said to be between 61 to 80% intensity.

The fifth is the Normal Tolerance Level % parameter. This is defaulted to 15.  This means that any deviation from the
average iris color of plus or minus 15 will indicate a degenerative stage controlled by the above parameters.

File Exit Command
The File|Exit command exits IriSearch Pro.  If you’ve modified documents without saving, you’ll be prompted to save
before exiting.
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Edit Undo Command The Edit|Undo command restores the image in the current window to the way it was before your
most recent image manipulating operation.

Edit Cut Command The Edit|Cut command removes the selected image and places the image in the clipboard.
Choose Edit|Paste Command to paste the cut image into another window. The image remains in
the clipboard, and can be pasted multiple times.

Edit Copy Command The Edit|Copy command leaves the image intact and places an exact copy of it in the clipboard.

Edit Paste Command The Edit|Paste command inserts the image currently in the clipboard into a newly
created window.

Edit Paste Into If you have an image copied to the clipboard, this option allows you to paste the clipboard image
into the currently selected image.  You are able to select an exact co-ordinate, or you can get
IriSearch Pro to automatically place the image for you.
To specify placement, enter the x & y co-ordinates in pixels to position the image. This is useful when
you require absolute accuracy when combining images into a single file.
The Paste|Into command also offers you 9 positions where you can place your image from top left to
bottom right on your canvas.
Once you have made your entries or selection, click OK.

Edit Clear Clears the current active image.  If you have a region of the image selected, this is the area
that will be cleared.

Edit Crop Removes the outer boundaries of a selected area on an image.  The cropped region of the image is
discarded.

Edit Purge Removes undo and clipboard information from the computer’s memory.

View Normal The View|Normal returns the image to 100% magnification. This is the original capture size.

View Zoom In The View|Zoom In function increases the size of the image by 25% increments with a maximum of
400%.

View Zoom Out The View|Zoom Out function decreases the size of the image by 25% increments.

View Zoom To Selection Zooms into a selected region of the image.

View Zoom By Selects a percentage to zoom in or out by.

View Full Screen The View|Full Screen displays the image to a size that fills the entire screen.

View Show Grid Overlays a reference grid over the top of any images you have loaded. The matrix size is 30 x 30
pixels.
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Adjust the colour properties of an image or its selected marquees.

Colour Balance Vary the levels of Cyan, Magenta, and Yellow components of an image.
Brightness/Contrast Adjust the brightness and contrast levels.
Saturation/Hue Change the intensity and colour spectrum of the image.
Gamma Correct colour intensity over specific ranges.
Invert Inverts (negative) the colours in an image.
Gray Scale Convert the image to black & white.
Equalize Equalizes the intensity of the current image.
Threshold Converts images to high contrast black & white.
Posterize Imposes a poster effect on the image.

Duplicate Creates a copy of the current image. This feature is useful when you wish to modify the existing file
and do not want to destroy the original.

Stitch Joins two images in a landscape format. Select the image you want to be on the left hand side, then
stitch.

Hemispherical Stitch Same function as Stitch but allows two directions, N/E and E/W.  Hemispherical Stitch also allows
any section to be joined. Make sure the image you wish to appear in the North position is active
before stitching, and the East position for the other orientation.

Image Size Change the physical size of the image.  This alters the actual dimensions of the image.
You can resize by absolute pixels or by percentage and have the option of locking or releasing the
aspect ratio. The aspect ratio controls the length by width proportions of an image.

Image Canvas Size Makes the canvas upon which the image is displayed larger or smaller.  If the canvas is
made larger, you may select where on the new canvas the image is to be placed.

Image Rotate Rotate the image either 90 degrees Clockwise (CW) or Counter Clockwise (CCW).  You can also
rotate the image by 180 Degrees to avoid rotating the image twice.

Image Flip Flip the image either horizontally or vertically by its axis.  The new image is a mirror
image of the existing image.

The Selection tool allows you to define all or part of an image for any additional processing.

All Clear marquee and select the whole image to work upon.

None Clear all selected marquees.

Inverse Makes active the selection outside of the areas around your marquees.

Region Shape Change the current shape of the marquees to one of the following: Rectangle, Ellipse, Rounded Rectangle,
Freehand.
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Selects what function you want the mouse pointer to perform:

Normal Mouse pointer functions as a normal pen when drawing.

Marquee Select an area of the image for editing. Selects an area of the image for Cut/Copy/Paste functions to
work with.  The shape of the marquee is determined by the Region Shape selection in the Select menu.

Eye Dropper Use the mouse to set the Draw Colour directly from an area of the image. Move the mouse over the
image to the area, which contains the colour you want to select.  Clicking on the image will set the new
Draw Colour.

Measure Measure the distance between two points on the image. Select a point on the image that you want to
measure from, and drag the mouse to the point you want to measure to.  A line will be drawn so you
can see where you have come from.  When you have the measurement, release the mouse button.  The
tracer line will be removed for you.

The measurement is recorded in the co-ordinate section of the Info Page and is saved along with other
file data in the File Info Page. The measurement will also be saved to your Report if you have enabled
this feature.

Drag Move your marquee to a different location. Click on your marquee and, while holding the mouse down,
drag it to a new location.  When you are happy with its position, release the mouse button.

Draw Freehand
When in the normal drawing mode, the mouse will work as a pen.  The colour and line thickness is selected by the Draw Colour
and Draw Line Thickness menu selections.

Draw Line
This will draw a line between two points on the image.  Select the starting point and hold the left mouse button down.  Move the
mouse to the finishing location and release the button.  The appearance of the line will depend upon the selected Draw Colour and
Draw Line Thickness setting, and whether you have selected Solid Line Drawing or Dashed Line Drawing styles.

Draw Square / Rectangle
Draws a rectangular object onto the current image.  Select and hold down the left mouse button at a starting corner of the
rectangle you wish to add; and drag the mouse to the opposite corner.  The rectangle will appear as you release the mouse
button.

Draw Circle/Elipse
Draw an elliptical object onto the current image.  The shape of the ellipse will be determined by the starting and finishing
locations of the mouse.

Draw Fill

This will fill the selected marquee with the current Draw Colour setting.

Draw Text
This will allow you to write notes on your image.  Select a point on the image where you want to make notes.  A window will pop
up allowing you to select the appearance of your text.  Once this is completed, a dialog box will appear asking you for the text that
you want to display.  Clicking on OK will record the text onto your image.
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The text can be picked up and dragged to a new location. Click the Text button on the Toolbar to drop the text onto the image.

When selecting this tool for a second time, the text you entered previously is held. You can drop this text again, edit it, or discard it
and type in new text.

Draw Arrow Command
Draws an arrow onto the image.  The arrow can point Up, Up Right, Up Left, Down, Down Right, Down left, Left, Left Up, left
Down or Right, Right Up and Right Down. Enter the first letter or two letters of the orientation you want. The arrow can be picked
up and dragged to a new location. Click the Arrow button on the Toolbar to release. The arrow size can be set by selecting Arrow
Size. Arrow size is defined in unit increments.

Draw Erase
The mouse can be used to erase unwanted areas of the image. The eraser size is determined by pen size and erases pixels in the
path of the eraser. To set eraser size, select Line Thickness.

Draw Colour
Selects the colour that any objects drawn onto the image will appear in.  This will affect lines, arrows, freehand drawing, fill,
ellipses and rectangles.

Draw Line Thickness
This selects how thick any lines will be drawn in.  Type in how many pixels wide you want the lines to be. Dotted lines will only
draw at 1 pixel wide. A solid line will be drawn if any other value is set.

Draw Arrow Size
Select how large arrows will be when it is drawn on the screen.

Filter Sharpen Sharpens the selected image by 20%.

Filter Sharpen More Sharpens the selected image by 50%.

Filter Sharpen/User Defined Allows you to specify the degree of sharpness. The amount of sharpness or blur is selected by
slider control in the range of – 100% blurring) to +100% (sharpening). Sharpness can also be
selected on any of the primary channels, Red, Green, or Blue. The default is all.

Filter Noise Despeckle Despeckle allows removal of dust and scratches from scanned images.

Filter Blur Blurs the selected image by 20%.

Filter Blur More Blurs the selected image by 50%.

Filter Blur/User Defined Allows you to specify the degree of blur. The amount of sharpness or blur is selected by slider
control in the range of – 100% (blurring) to +100% (sharpening). Sharpness can also be
selected on any of the primary channels, Red, Green, or Blue. The default is all.



30

IriSearch Pro 2000 User Manual

American Loads standard American chart.
German Loads standard German chart.
Integrated Loads optional Integrated Iridology chart. “The Iridologist” must be installed to access this chart. When

this chart is loaded, clicking on the Ciliary Zone, Pupil or Sclera will bring up relative information from
“The Iridologist”.

Psychology Loads Psychology chart.
Zone Loads Zone chart.
Sector Loads Sector Charts.
Time Loads optional Time chart

Overlay Right
Loads the currently selected chart for the right iris.

Overlay Left
Loads the currently selected chart for the left iris.

Offset
Allows you to offset the inner most ring (pupil ring).

Rotate Chart
Allows chart rotation either clockwise or anti-clockwise. Chart rotation of up to 360° allowed. You may enter directly the degree of
rotation or select with increase/decrease button. To rotate anti- clockwise, a negative number is required. To establish how many
minutes to rotate, a one-minute rotation requires 6 degrees. If you are unsure of the current rotation position, the reset button
returns chart to 0/60 position.

Lock
Locks the current chart into position.

Clear
Removes the currently selected chart from the image.

View
Switches between Full and Minimum chart mode. Minimum is the default view. Full displays all sectors and zones of the selected
chart.

Body System
Selects body system, charts the body system and then blocks system components on the chart. When this function is on, all
components of the selected system will be identified on the chart. In the Info Box, the System page will be selected and a graphic
of the correlating system can be viewed.

Reverse Blocking
Reverses system blocking on the current chart to view iris detail in selected body system.

Colour
Provides a colour palette for customizing chart colour.
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Allows you to access optional testing instruments supplied by Naturopathic Technologies.

This may include such devices such as Allergy Testing, MagnaGraph, Ryodoraku, Bio-Functional Diagnosis, Electro-
acupuncture or any other device.

The resources menu provides you with access to many resources that are available today. Some are available as standard items
in IriSearch Pro and others are optional. Resources provided as part of the package are Iris Densities, Iris Signs and Diet Pro.
You will find that these are readily available to you when you go to this menu. Other options can be simply plugged in whenever
required. There are now many CD-ROM Natural Therapy titles available that may provide you with valuable resource material.

The Iridologist is one such resource and has been written specifically to work closely with IriSearch Pro. Written by a high
profile local Iridologist and published by NT, The Iridologist provides extensive resources on, European Constitiutions, Sclera
Signs, Pupil Signs, Collarette Signs (ANW), Psychological Indicators, as well as an Integrated Iridology Chart  (a blend of
European, American and specifics to the author). The information in The Iridologist is supported by text, graphics and
example photographs. This makes the information very comprehensive and clear. All information in The Iridologist can be
printed or alternatively can be placed into templates and edited to meet your specific requirements for clinical reporting.

Iris Densities Displays the Iris Densities help file.
Iris Signs Displays the Iris Signs help file.
Brown Irides Displays the optional “Brown Irides” resource CD.
Inspection of the Tongue Displays the optional “Inspection of the Tongue” resource CD.
The Iridologist Displays the optional “The Iridologist” resource CD.
HyperHealth Displays the optional “HyperHealth” resource CD.
Diet Pro Displays the nutritional module of the program.
NaturBase Displays the optional “NaturBase” resource CD.

Window Arrange Icons Command The Window|Arrange Icons command arranges all iconized windows
into rows along the bottom of the application’s main window.

Window Cascade Command The Window|Cascade command arranges all document windows from the
top-left position of the application’s main window so that the title bar of each
is visible.

Window Close All Command The Window|Close All command closes all document windows open in
the application.

Window Tile Command The Window|Tile command arranges all document windows side-by-side in
a non-overlapping pattern.
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Turns on and off Information Dialogue Box (Info Box). This page records information about the currently selected file.

General information about the current file is stored in this page. The Notes button opens a text edit window for lengthy notes.
The Client Record button opens the comprehensive client report database.

For the Condition Stage to report, a sample Average Iris Colour must be made. Once this is done the program will calculate any
area you point at or define in degeneration levels.

Clicking on any area of interest will capture Average Iris Colour, Current Location Intensity, Stomach Zone Condition, and Chart
Location. Any measurements taken are automatically stored.

Information such as Average Iris Colour, Location Intensity, Stomach Zone Condition and any measurements taken are also
recorded here. The Details button opens the window containing all colour channel information on Average Iris Colour and Location
Intensity.

To label samples taken, choose an item from the Sign or Area drop-down list. If the item you want has not been created, click on
the Edit button and edit the list.

Sample Iris Colour
This function samples the colour of the iris between the stomach zone ring and the outer ring of the current chart. The average
colour is then calculated. A chart must be loaded and locked for this function to operate. The Get Sample button executes this
function. The results are broken down to channels Red, Green, Blue and Intensity with their compliments Cyan, Magenta, Yellow
and Black.

To sample the Average Iris Colour, click the Get Sample button on the NT Logo portion of the window. This will immediately
calculate the iris colour and display the breakdowns. A system chart must be loaded for the program to calculate, otherwise this
function will not act. The program samples from the periphery of the iris to the stomach zone.

Current Location Intensity

This function is always operational within an iris. A chart does not have to be loaded. Wherever the mouse pointer is posi-
tioned, a display of the current position intensity and all channel colours will be present. This function will not work outside the
Normal Mode marquee selection.

The Get Sample button enables you to select an area to be sampled. To sample an area, first define the area you wish to
sample. This is done with the selection tool.

When you have a chart loaded you may elect to take a sample colour. If you wish to do this simply click the left mouse button on
the area of interest and this information will be saved in the Info Box under File Info. The program will record the colour, the
location and you may select an iris sign label from the drop-down list. This drop-down list may be edited by selecting Edit. Details
of the colour and intensity breakdown can be viewed by selecting Details. This method only records the last sample taken. This
information is saved with the photograph along with other file information you have entered.

If you wish to take multiple samples or report these out, make sure you have the setting enabled in the
File|Settings|Program|General menu. When you click on an area with a chart loaded the following information is sent to the report
window: Sample with measurements in the primary colours, Red, Blue and Green, Intensity and a sample of the colour itself. These
figures are useful if you want an accurate measuring tool to monitor any colour changes over a period. “K” stands for black and is
the opposite of “I” Intensity.

Intensity can be defined as a percentage of brightness on a grayscale, 0 being most intense (clear white) and 100 being least
intense (solid black).

Other information saved is the location of the sample. This is identified from the chart by name and also as a grid reference,
providing an X and Y value. You will notice that under Co-ordinates in the Info Box, a grid reference is always active.
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The condition stage of the current sample is also recorded. The will be either Normal, Acute, Sub-acute, Chronic or
Degenerative. These calculations may be altered to suit the practitioners requirements under
File|Settings|Program|Condition Stage.

The last information that is saved is the prompt, Sign. This is so you may record the particular iris sign that has been
sampled. Simply type in the iris sign that you are observing and you then have comprehensive information on the sample
stored. If you are using Comprehensive Reports, iris sign and area labels are available from the menu.

Turns on and off the Report Box. The Report Box provides the ability to create, edit and print reports in two ways,
Simple and Comprehensive.

a) Simple Report
The Simple Report allows you to create reports and to take sample colours and measurements from the iris. This report
type can be open when you’re viewing the iris photograph and you can make manual edits to the report. This type of
report may contain only text; it will not allow photographs, graphs or charts. This report may also be linked to the chart
you are using for fast reporting. This will link any body area on the chart to any template that you have created in the
Template Box under Charts. When you create a new template make sure you use exactly the same name that is presented
in the chart. Otherwise, the link will be broken; the program will not be able to find your template. When templates are
passed into the report, any formatting will not be included. If you wish to have formatting controls, use Comprehensive
Report.

The report can be printed along with the photograph by selecting the Print function.

b) Comprehensive Report
The Comprehensive Report allows you to create reports and to take sample colours and measurements from the iris, in
exactly the same way as the Simple report. This report type cannot be open when you’re viewing the iris photograph. If
you are taking sample colours or measurements, do this first then open the Report.

You can make manual edits to the report also. This type of report may contain text, but also allow photographs, graphs,
charts and many types of other information. This report may also be linked to the chart you are using for fast reporting.
All formatting is retained when passing templates over to this report type, unlike Simple Reports.

This report type provides you with virtually unlimited power for reporting. It has been devised to allow those practitioners
who wish to present professionally, for those who wish to use the program to design lecture graphics for overheads or
slide shows, design marketing tools such as brochures or charts, sophisticated cover sheets for their reports. This report
type is very powerful and allows the importing of many types of data from other applications as well. Some of these are:

1)   Microsoft Word
2)   Microsoft Excel
3)   Microsoft Power Pont
4)   Microsoft Word Art
5)   Microgafx Picture Publisher
6)   Adobe PhotoShop
7)   Corel Presentations Chart
8)   Corel Presentations Drawing
9)   Corel Quattro Pro
10)  Video Clips
11) Wave Sounds
12) Media Clip
13) Organisation Chart

and many, many more.

On opening this report type it automatically inserts the client name, date and time, and a copy of the image you are
working with. The image size can be adjusted to suit by selecting the image and dragging the resize handles. The image
can be moved by selecting, drag and drop to the new location. Additional images and text can be inserted.
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Some samples have been provided as a starting point. These may be edited or deleted. The Comprehensive Report is sophisticated
and has its own set of commands.

The File menu provides commands for creating new files, opening existing files, saving files, printing files, and exiting the Report
Editor.

Save and Exit Save the current file and exits.
Print Print the current file.
Page Setup Set page characteristics.
Exit Exit Report Editor.

The Edit Menu provides commands to access the clipboard and manipulate text.

Undo Undo the previous operation.
Redo Restore the last edit removed by Undo.
Cut Move image from current window to the clipboard.
Copy Copies image from current window to the clipboard.
Paste Move image from the clipboard to new window.
Clear Clear the image from the display.
Select All Selects entire contents of the report.
Find Finds the occurrence of any text specified.
Find Next Finds the next occurrence of text specified with the Find command.
Replace Replaces the found text with the specified text.

The View Menu provides commands to change the view of the Report Editor.

Toolbar Show or hides the Toolbar.
Format Bar Show or hides the Format Bar.
Status Bar Show or hides the Status Bar.
Ruler Show or hides the Ruler.

The Insert Menu provides commands to insert objects, text and photographs into the report.

Object Inserts an object type into the report.
Photo Inserts a photograph from file into the report.
Text Inserts text from file into the report.
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The Sign Menu provides labels to insert into the Report Editor to indicate iris signs that have been sampled.

The Signs can be created or edited from the Info Box under File Info. Click the Edit button next to the Sign drop-down
list.

The Area Menu provides labels to insert into the Report Editor to indicate iris signs or areas that have been measured.

The Areas can be created or edited from the Info Box under File Info. Click the Edit button next to the Area drop-down
list.

Window Show Tools
Turns on and off the Tool Bar. The default setting is on. It may be useful in some instances to turn off the toolbar for
additional screen space. The toolbar functions can also be located in the menus.

Window Report Type
Toggles between the two report types, Simple and Comprehensive. Once selected, that mode will be enabled as your
default until you select the other option.

Help table of contents The Help|Contents displays the help contents page.

Search For Help On Enables you to type in key characters or words to find help on a certain topic or
function.

How To Use help Runs a tutorial on how to use the help system.

About… Describes the version of the software you are currently running.

The Format Menu provides commands to change the characteristics of your text.

Font Selects the font for the current selection.
Bullet Style Inserts a bullet on the current line.
Paragraph Formats current or selected paragraph with alignment, indentation, spacing and line spacing.
Tabs Sets tabulation.



36

IriSearch Pro 2000 User Manual

Arrow key Moves the cursor left, right, up, or down in a field.

End or Ctrl+Right Arrow Moves to the end of a field.

Home or Ctrl+Left Arrow Moves to the beginning of a field.

Page Up or Page Down Moves up or down in a field, one screen at a time.

Backspace Deletes the character to the left of the cursor, or deletes selected text.

Delete 1 Deletes the character to the right of the cursor. Or, deletes selected text.

Alt Selects the first menu on the menu bar.

Letter key Chooses the menu, or menu item, whose underlined letter matches the one you type,
when a menu has focus.

Alt+Letter key Pulls down the menu whose underlined letter matches the one you type.

Left or Right Arrow Moves among menus of the main menu bar.

Up or Down Arrow Moves among menu items within a drop-down menu.

Enter Chooses the selected menu item.

Tab Moves from field to field (left to right and top to bottom).

Shift + Tab Moves from field to field in reverse order

Alt + letter Moves to the option or group whose underlined letter matches the one you type

Arrow Key Moves from option to option within a group of options

Enter Executes a command button. Or, choose the selected item in a list box and executes
the command

Esc Closes a dialog box without completing the command. (Same as Cancel)

Alt + Down Arrow Opens a drop down list box

Alt + Up or Down Arrow Selects item  in a drop down list box

Space bar Cancels a selection in a list box. Selects or clears a check box.

Ctrl + Slas Selects all the items in a list box

Ctrl + Backslash Cancels all selections except the current selection

Shift +Arrow Key Extends selection in a text box

Shift + Home Extends selection to first character in a text box

Shift + End Extends selection to last character in a text box
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The following keys can be used from any window, regardless of the application you are using.

Ctrl+Esc Switches to the Task List.

Alt+Esc Switches to the next application window or minimized icon, including full-screen programs.

Alt+Tab Switches to the next application window, restoring applications that are running as icons.

Alt+PrtSc Copies the entire screen to Clipboard.

Ctrl+F4 Closes the active window.

Shift+Left or Right Arrow Selects text one character at a time to the left or right.

Shift+Down or Up Selects one line of text up or down.

Shift+End Selects text to the end of the line.

Shift+Home Selects text to the beginning of the line.

Shift+Page Down Selects text down one window. Or, cancels the selection if the next window
is already selected.

Shift+Page Up Selects text up one window. Or, cancels the selection if the previous window
is already selected.

Ctrl+Shift+Left or Right Arrow              Selects text to the next or previous word.

Ctrl+Shift+Up or Down Arrow Selects text to the beginning (Up Arrow) or end (Down Arrow) of
the paragraph.

Ctrl+Shift+End Selects text to the end of the document.

Ctrl+Shift+Home Selects text to the beginning of the document.

Alt+Spacebar Opens the Control menu for an application window.

Alt+Hyphen Opens the Control menu for a document window.

Alt+F4 Closes a window.

Alt+Esc Switches to the next application window or minimized icon, including full-screen
programs.

Alt+Tab Switches to the next application window, restoring applications that are running as
icons.

Alt+Enter Switches a non-Windows application between running in a window and running full
screen.

Arrow key Moves a window when you have chosen Move from the Control menu. Or, changes
the size of a window when you have chosen Size from the Control menu.


